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About This Guide 
Polycom ReadiManager LX100 comes with a Microsoft Outlook component that 
enables videoconferences to be scheduled and managed directly from the Microsoft 
Outlook window. 

This guide describes how to use these scheduling features in Microsoft Outlook.  

If you have not yet installed the Polycom ReadiManager LX100 component for 
Outlook, see Setting Up Microsoft Outlook for Use with Polycom Video Conferencing 
on page 39. 

Scheduling features can also be accessed and used from the web-interface of 
Polycom ReadiManager LX100. Complete information about setting up Polycom 
ReadiManager LX100 and using scheduling features from the web-interface is 
covered in Polycom ReadiManager LX100 Scheduling Administrator’s Guide.  

Note: This book focuses on scheduling and managing videoconferences. However, not all 
resources scheduled through Polycom ReadiManager LX100 need to include video 
capabilities. Your Polycom ReadiManager LX100 network may include non-video or 
audio-only resources. You can even use Polycom ReadiManager LX100 to 
schedule conference rooms, without scheduling equipment. These can be 
scheduled for conferences in the same way you would schedule a video resource. 
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Videoconference Features in Outlook 
Videoconferences can be scheduled and managed from your Calendar in Microsoft 
Outlook. When you schedule a videoconference, Polycom ReadiManager LX100 
reserves people, bandwidth and resources (equipment, rooms, and so forth) for a 
particular date and time. It checks other planned conferences, compares them 
against the maximum video bandwidth settings, and either allows the conference to 
be scheduled, or suggests that you select a different time. 

After the Microsoft Outlook component of Polycom ReadiManager LX100 has been 
installed on your computer, a new menu appears on the Microsoft Outlook menu bar: 
the Video menu.  

 

The Video menu contains these commands: 

 Logon Settings. During the installation of the Microsoft Outlook component, a 
few questions are asked that will automatically populate your login information. 
Unless your logon information changes, you won’t need to change these settings. 
(For details, see Logging On from Microsoft Outlook on page 41.) 

 Update Calendar. Use this command to update your Outlook Calendar with 
scheduled conferences entered in the ReadiManager LX100 web interface. In 
most situations this will not be necessary to perform on a regular basis. (For 
details, see Updating Your Calendar with Scheduled Videoconferences on page 
28.) 

 Manage Conferences. Use this command to make changes to conferences that 
are already scheduled or are currently in progress. (For details, see Managing 
Scheduled Conferences on page 29.) 

 Help. Use this command to see information about how to use Polycom 
ReadiManager LX100. 

 About. This command shows the version number of Polycom ReadiManager 
LX100 and provides a link to the Polycom web site.  

In addition to the Video menu, you’ll find a new tab in the Appointment or Meeting 
Request window that enables you to schedule videoconferences, as described on the 
next page. 
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Scheduling a Videoconference 
Scheduling a videoconference in Microsoft Outlook is started just as you would 
schedule any other appointment or meeting. When you create an appointment, a new 
tab—the Conference Resources tab—appears in the Outlook Appointment or Meeting 
Request window. 
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Because scheduling of videoconferences is done right in the meeting request 
window, you can also use the Appointment and Scheduling tabs to invite individuals 
to the meeting, enter notes, and attach documents, just as you would for any other 
meeting. 

Scheduling with Polycom ReadiManager LX100 includes many features. You can: 

 Use filters to narrow the available resources to those that match the equipment, 
conference room type, and room attributes you need. 

 Request a specific date and time, or let ReadiManager LX100 suggest an available 
time for the resources desired. 

 Add a guest (a participant who is not on this video network). 

 Change from the default settings for call speed, conference auto-start or not, the 
video layout mode for multipoint calls. 

Note: The particular features available in to you depend in part on the user permission set 
by your Polycom ReadiManager LX100 administrator. Some features may not be 
available to all users.  

The next few pages first describe the basic scheduling process and then provide 
details about using additional features. 
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Creating the Video Meeting Request 
The basic process for scheduling a videoconference includes these steps, which are 
explained in detail below:  

 Tell Microsoft Outlook to create a new meeting 

 Enter a Conference Name and Reference Number 

 Click Load Network 

 Select Resources and Add Guests 

 Set Date and Time 

 (Optional) Revise Conference Contact information 

  (Optional) Adjust the advanced settings 

 Click Create Schedule 

 Enter any additional information on the Scheduling or Appointment tabs 

 Send the meeting 

To create a video meeting request and schedule a videoconference 

1. Display the Microsoft Outlook Calendar, and create a new appointment. 

This can be done using any one of these methods: 

 Select the New Appointment icon from the Outlook Calendar menu.  

 Select File > New > Meeting Request to send an invitation to other users in 
their Outlook Calendar. 

 Select File > New > Appointment to enter an event on only your calendar. 

 Double-click on the visible calendar where the meeting needs to start.  

The Appointment tab will appear first. On this tab, people can be added to the 
meeting on the “TO” line, a subject can be entered, times can be selected, etc. 
just like any other meeting. If the meeting was created without a “TO” line simply 
click the Invite Attendees button to add it. 

Note:  If the people needed in the meeting have a difficult schedule to work around, 
start on the Appointment tab and find a time that all people can get together 
before proceeding to step 2, to schedule conference resources. Otherwise, go 
on to step 2 and select the conferences resources based on the time the 
resources are available and return later to the Appointment tab to select the 
attendees. The date and time will automatically be copied from the Resource 
tab. 

2. Next, click the Conference Resources tab.  

This tab provides the necessary information to schedule the video-related 
resources.  
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3. Click Load Network. 

If you entered a Subject on the Appointment tab, it is entered in the Conference 
Name field.  

If Polycom ReadiManager LX100 is set up to use automatic reference numbers, 
you will see your billing number appear in the Reference # field. 

 

4. If either the Conference name or Reference # is not displayed, enter it now (both 
are required). 

The Reference # is recorded with the details of the conference and can be used 
for billing purposes. The Conference name will be copied back to the subject line 
on the Appointment tab after you click Create Conference button. 

Note:  The IT group may have set a default for the Reference #, but it can be altered 
just by highlighting the content and adding or replacing the information. If the 
Reference # automatically displays, be sure to not replace it unless that is the 
suggested procedure from the IT group. 

5. In the list of Resources, expand the network folders by clicking the plus signs to 
find the resources you want.  

Areas are the highest-level folders, zones are inside the areas, resources are 
inside the zones, and equipment is inside the resource. 

It is the resource level that you will select and add to the conference. 

You can also use Filters to help locate resources with particular characteristics. 
(For details about filtering, see page 10.)  
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6. Add resources to the conference by selecting the resource on the left and clicking 
the Add button to move it to the Selected Resources box on the right.  

Note:  If ReadiManager LX100 determines that a multipoint call can be placed using 
one of the MP-capable video endpoints selected for the call, it will use the first 
MP-capable endpoint selected, regardless of the order displayed on screen.  

Although you may see an MCU in the list of resources, do not add it explicitly to 
the conference as a resource. ReadiManager LX100 will automatically schedule 
that resource behind the scenes, if it is needed. 

7. Click the Date/Time tab and enter the date and times for the conference. (For 
details, see page 12.)  

The current date and time are automatically inserted. 

To make the conference a recurring conference, see Creating Recurring 
Conferences, on page 15. 

8. (Optional) Edit the Conference Contact, Contact Phone, and Contact Email, if 
appropriate. 

This information will appear on messages about the conference that are sent to 
attendees. Polycom ReadiManager LX100 automatically inserts your contact 
information.  
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Note:  The conference contact is specific to this conference. In addition, there are 
contacts and facilitators associated with each resource and room that are 
added to this conference. For details, see the Polycom ReadiManager LX100 
Scheduling Administrator’s Guide. 

9. (Optional) Adjust the advanced settings (see Using the Advanced Settings on 
page 21). 

Note: If the Advanced Settings button does not show on your screen, these features 
are not part of your user permissions.  

10. Click Create Schedule. 

ReadiManager LX100 checks the request against other scheduled conferences 
for video bandwidth limits across the entire network, and checks the availability of 
selected resources. If everything is clear and there are no conflicts, the 
conference is scheduled and entered into the database.  

11. If you did not yet add individuals to the meeting on the Appointment tab, do so 
now. 

Click the Appointment tab and enter any other information if necessary.  

The subject line will be filled from the conference name on the Conference 
Resources tab.  

12. When you are finished, click Send. 

This step is required to notify all the recipients of their new conference. 

All participants and facilitators connected with the conference will receive a 
confirmation email shortly. Those people you invited via the Appointment tab will 
receive a calendar notification as well.  

If the user creating this conference has a user profile of “request only,” a 
message is also sent to the Conference Administrator that the conference needs 
approval. For more information, see Approving a Requested Conference on page 
32. 
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Finding a Resource that Fits Your Needs (Filtering) 
The Filters tab contains options that let you locate resources and equipment with the 
features you need. 

 

To filter network resources 

1. In the Schedule Conference screen, click the Filters tab. 

2. Select the criteria that you want to match. The filter will find the resources that 
match all of the criteria you enter. 

You can specify any of the following.  

 Equipment (type and model). Rooms can be equipped with video 
endpoints, VCRs, projectors, and so forth. When trying to locate a particular 
room, use this filter to limit the view to just the rooms containing required 
equipment.  

Note:  If your network administrator has defined an equipment type called “Non-
Video” or “Audio Only,” you can use it to filter for rooms without video 
equipment when a conference room is needed, but there is no need to use 
videoconferencing. This keeps the room with video equipment free for 
those who need to schedule a videoconference.  

 Room capacity . The number you enter will set the minimum filter value for 
the number of people a room can contain. Any rooms with less than this 
number will not be shown as available. 

 Style of room. Use this field to filter on rooms with a particular room layout 
such as classroom, large conference, small conference, and so forth. 

 Internet connectivity. Check this box to identify only rooms that have an IP 
connection to the Internet 

 Text search. Enter a resource name or nickname for which you want to 
search.  

If you want to filter by date and time, use the Date/Time tab. 
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3. When you have finished entering criteria, click the Resources tab again. 

ReadiManager LX100 searches details about the resources to find matches for 
your criteria, and displays the filtered results in the Resources hierarchy. 

Tip: You can toggle back and forth between the Filters and Resources tabs. Filter to 
find the right resource for one part of the conference, and add it to the schedule. 
Then Filter for another resource, add, and so forth.  

Note: For Filtering to work effectively, characteristics of the resources and equipment in 
your network must be defined in the database. Lack of resources that match your 
request may mean that such resources are not available, or it may mean that the 
characteristics you are searching for were not defined for any resources. For 
more information, contact your Polycom ReadiManager LX100 Administrator.  

To find resources available at a particular date and time 

1. On the Date/Time tab, check the box next to Only show resources that are 
available at this date and time. 

 

2. Enter the date and duration for the conference. 

3. Enter the desired time. 

4. Click the Resources tab. 

ReadiManager LX100 applies the filter and shows only those resources available 
at the date and time you specified. 
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Using My Favorites to Select a Resource 
You can make resources that you schedule frequently  easily accessible by putting 
them in the My Favorites folder.  

To add a resource to My Favorites  

 Highlight the desired resource, right-click and choose Add to Favorites. 

 
The item is copied into the Favorites folder, where it is labeled using its 
nickname. 

 

Note:  Resources can only be added to the My Favorites folder if they exist in the 
Local Network. Resources that appear in other networks cannot be added to 
the My Favorites folder. 

To schedule a resource from My Favorites 

 Highlight the desired resource in the My Favorites folder and click Add. 
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Requesting Specific Dates and Times 
You can request a particular day and time on the Date/Time tab.  

 

To specify the date and time for a conference 

1. On the Resources tab, select the resources you want to include. 

2. On the Date/Time tab, enter the date and duration for the conference. 

3. To set the time, do one of the following: 

 If you know the time you want, enter it in the Start at field. 

 If you have a time range in mind, click Start time between and enter the 
starting and ending times you want to consider. ReadiManager LX100 will 
find the earliest time in that range which works for all selected resources. 

Click the Calendar button to view current settings for the resources.  

For more about fields on the Date/Time tab, see Fields on the Date/Time tab. 

Fields on the Date/Time tab 
 Only show resources that are available at this date and time. Check this box 

if you want to filter for resources available at the date and time you enter on this 
tab. Then click the Resources tab to have ReadiManager LX100 show you 
available resources. Leave this box unchecked if you have already selected 
desired resources and want to set the conference date and time. 

 Date. Select the desired date for the conference. Defaults to today’s date. 

 Duration: The length of time for the conference. Defaults to the duration 
indicated on the Appointment tab. 

 Start at: Enter the time for the conference, or click Now to set the current time. 
Defaults to the current time when you enter this tab. 
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Note: If you click the Now button to select the current time and then continue to 
set other conference parameters before pressing Create Conference, the start 
time for the meeting may become a time in the past. To prevent problems when 
selecting the current time, click the Now button last, just before click Creating 
Schedule. 

 Find earliest start time between: Select this option to have ReadiManager 
LX100 find a time that works for the resources already selected on the resource 
tab. 

 View combined resource button : Click this button to pop-up a view of the 
day specified in the Date field, showing available times for all the selected 
resources.  

 

When displaying available time, ReadiManager LX100 takes into account the 
time zones for each resource, although the times selected are for your time zone.  

How Much Time is Reserved  
In addition to the meeting duration, ReadiManager LX100 schedules additional time 
before and after the meeting, depending on the requirements for the particular 
resource. 

When your Polycom ReadiManager LX100 Administrator defines your video network 
resources, each room is assigned Setup Minutes and Breakdown Minutes that are 
needed before and after a conference. These are automatically added to the 
conference duration time when ReadiManager LX100 schedules your conference, so 
that adjacent conferences do not conflict with one another. However, they do not 
appear in the scheduled conference times; they are handled behind the scenes. 
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Creating Recurring Conferences  
Conferences scheduled through ReadiManager LX100 can be created as recurring 
conferences. In Microsoft Outlook, the same Recurrence feature used to create other 
types of recurring meetings is used to schedule recurring conferences. 

The maximum number of times a conference can recur is determined by your 
Polycom ReadiManager LX100 administrator. If you exceed the maximum, you will 
receive a message to that effect, asking you to reduce the number of recurrences.  

Note: Recurring conferences can only be changed on an individual basis. 

To create a recurring conference 

1. While you are in the VideoMeeting window, click the Recurrence button. 

2. Complete the Appointment Recurrence dialog box, to specify how often the 
conference should recur, and click OK. 

Note:  Polycom ReadiManager LX100 does not support creation of annual recurring 
conferences, but does support Daily, Weekly, and Monthly meetings. 

3. Finish creating the conference, as you normally would. 

When you click Create Schedule, ReadiManager LX100 checks availability and 
bandwidth as it normally does, and reserves the resources for all recurring 
meeting times, if there are no conflicts. 
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Viewing Details about a Resource  
The Details tab shows specific characteristics of a resource after it’s been added to 
the Selected Resources list.  

To see details about a resource that has been added to a conference 

 Select the resource in the Selected Resources list. 

A Details tab appears on the left, and shows the characteristics of the selected 
resource.  

Note: This tab does not appear until one of the resources in the Selected 
Resources list is selected. 
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Using the Legend 
The Legend tab defines the colors associated with resources. 

 

Setting the Host for a Multipoint Call 
Hosts can be designated when scheduling a multipoint calls. The advantage of 
designating a host is that attendees will know who the host is of the conference when 
the email notification for the conference is sent out.   

Note:  Selecting a host site does not control who is dialing, only who is responsible for the 
call. 

To designate a host 

 Right-click on the desired resource in the Selected Resources box of the 
Conference Resources window and choose Select As Host.  

 

“Host Site” will appear in parentheses next to the designated resource. 

Changing Dial-In Settings for Individual Resources 
You can specify whether a particular resource should dial-in to a conference.  

Note: If Dial-in Only is selected in Advanced Settings, Dial-In will be selected for all 
resources, and the dial-in setting for individual resources cannot be changed. 

If Dial-in Only is not selected and you select dial-in for one or more individual 
resources, a dial-in number and pass code will be created and sent to you in the 
reservation confirmation email.  
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To select a dial setting 

 Right-click on the desired resource in the Selected Resources or Guest box of 
the Conference Resources window and choose Dial-In.  

A check mark indicates whether Dial-In is currently selected.  

To allow a different endpoint to dial this resource, make sure this setting is not 
selected. 

 

  

Setting the Connection Type for Individual Resources 
You can set the type of connection to be used by individual conferences. The settings 
you can select are determined by the type of conference selected in the Advanced 
Settings. Available choices may include: 

 None. Use this setting to indicate that only the room is being reserved. When 
None is the only available selection, “Rooms Only” is selected as the Conference 
Type. 

 Bridged Audio. Use this setting to have an MCU create a dial-in number for this 
endpoint. When None and Bridged Audio are the only available setting, “Bridged 
Audio Only is selected as the Conference Type. 

 128, 256, 320, 384, etc. video. Use these settings to specify a particular 
connection speed for this endpoint. When these settings are available, 
“Video/Audio” is selected as the Conference Type. 

To set the connection type for an individual resource 

 Right-click on the desired resource in the Selected Resources box of the 
Conference Resources window and choose the appropriate setting.  

A check mark indicates the current setting.  
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Adding a Guest to a Videoconference 
Guests are participants who are not within your video network. For example, you 
might want to schedule a conference with a client or customer who will be attending 
from their company office, rather than from one of your conference rooms.  

Note: If you have a regular guest who is off your network and you want to be able to 
conference that guest in without entering the information manually each time, ask 
your Polycom ReadiManager LX100 administrator to set them up as an Off Net 
resource. Selecting an off net resource and adding it to a conference automatically 
places it in the Guests list.  

Note: Guests do not receive email notification about conference, so if you select Dial In for 
a Guest, be sure to send that person the necessary information for the dial in, such 
as date and time, and the conference ID for the MCU. 

To add a guest to a videoconference 

1. In the Conference Resources tab, click the Add Guest button. 

2. In the Conference Guest dialog box, enter the following: 

 Name. This name will be used to identify the guest on conference schedule 
email notifications to recipients. 

 Number.  The IP or ISDN number ReadiManager LX100 will use to reach 
the guest, if the call is auto-started. 

 Connect Type. Whether the connection to the guest is IP or ISDN. 

3. Click OK. 

Note:  The email address of the guest can be entered (manually or from the contact 
list) on the To line of the meeting request along with the other internal guests. 



Scheduling a Videoconference  

20  Polycom ReadiManager LX100 Scheduling in Outlook 

Creating Conference Notes 
Conference notes allow you to add information regarding the conference. What you 
type in the box Conference Notes dialog box is sent out in the email notification when 
the conference is scheduled. The notes are also available when you manage 
conferences. 

To add conference notes 

1. Click the notebook icon on the Conference Resources tab. 

 

2. In the Conference Notes dialog box, enter the notes for the conference. 

 

3. Click OK when you are finished. 
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Using the Advanced Settings 
After you click Load Network, the Conference Resources tab contains a button 
labeled Advanced Settings. Clicking it opens a dialog box in which you can specify 
default settings for these important scheduling details: 

 Selecting a Template 

 Type of Conference  

 Dial Options 

 Force MCU Usage  

 Auto-Start Conferences 

 Video Mode 

 Speed 

 People + Content 

 T.120 

Note: These settings can be changed for a particular videoconference. Be aware, 
however, that Polycom ReadiManager LX100 remembers the last setting used. If 
you want to change these on a one-time-only basis, you should return to the dialog 
box after the conference is scheduled and reset them to your desired defaults. 
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Note: The ability to view and change Advanced Settings depends on the permission 
settings associated with your user name. If you do not see an Advanced Settings 
button on the Conferences Tab, you do not have access to this feature. For more 
information, contact your Polycom ReadiManager LX100 administrator. 

Selecting a Template 
Templates are collections of advanced conference settings. When you are scheduling 
a conference and open the Advanced Settings dialog box for the first time, your 
default template is always selected, and the values in the Advanced Settings dialog 
reflect the settings associated with that template.  

You may have only one template available in Advanced Settings, or your network 
administrator may have created multiple templates to adjust the Advanced Settings in 
different ways.  

If you select a different template from the list, it will adjust the values throughout the 
Advanced Settings dialog. If desired, you can then make additional adjustments to 
fine-tune the settings for this conference.  
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Specifying the Type of Conference 
You can specify the type of conference this will be:  

 Rooms Only 

 Bridged Audio Only 

 Video/Audio 

Rooms Only 
Select Rooms Only when you only want to reserve the rooms themselves. Although 
equipment in them will not be available to other people, no bandwidth will be reserved 
for the conference. All other Advanced Settings for the conference become irrelevant, 
and are grayed out in the dialog box. Any conference that uses third-party audio 
conference systems (outside the control of the enterprise) would use this setting and 
simply utilize the conference phone in the room to dial into the third-party conference 
line 

Bridged Audio Only 
Select Bridged Audio Only when you want to set up a dial-in conference into which 
multiple people can dial. The bridge is reserved as an audio-only media, with no 
video media. Choosing this conference type automatically selects the Dial In Only 
and Force MCU Usage options. This means that an MCU’s resources will be 
reserved and used to create a dial-in conference. After you create the conference, the 
conference confirmation email you receive will include the dial-in number and pin 
code required to access it.  

With this type of conference, no bandwidth is reserved except the MCU. The rooms 
associated with the resources are reserved, so any equipment in those rooms will not 
be available to other people. This also does not reserve precious video resources on 
the MCU that would otherwise be reserved for a mixed audio/video call. 

Note: Only regular POTS audio phones can be used--not ISDN endpoints. 
Attempting to mimic an audio call using a 64K dial speed through an audio/video 
endpoint may result in the call being dropped, or in very poor audio quality. 

Video/Audio 
Video/Audio allows you to use a combination of video and audio connections in this 
conference, and to reserve the required bandwidth and equipment associated with 
resources, as well as the rooms. The conference can use a combination of both Dial-
In and Dial-Out, or you can specify that it should be Dial In only, if you want all 
connections to be made through one bridge. 
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Specifying Dial Options 
You can determine whether a conference will require all endpoints to dial in to the 
conference, or whether a combination of dial-in and dial-out will be allowed. 

When you want an MCU (also known as a “bridge”) to create a dial-in conference for 
which a particular phone number and pin code are created for all conference 
participants, use the Dial-In Only setting. With a dial-in conference, any audio or 
video system can dial in, and all participants will be connected to the same 
conference inside the bridge. This allows participants to dial into the bridge at their 
convenience from anywhere they choose.  

When you want to be able to dial-out to a video system, as well as to have 
participants dial in, use the Dial Out/Dial In setting.  

When you specify Dial Out/Dial In, you can specify the individual resources that you 
want to dial in. For example, you might specify that a particular end-point should use 
dial-in, in which case a bridge will create a dial-in number for it. For more information, 
see Changing Dial-In Settings for Individual Resources on page 17. 

Note: When selecting the Dial-in only option or Room Only option from the Advanced 
Settings dialog box, all selected resources are forced to be dial-in only. When you 
change that selection to Dial-in/Dial-out, the individual selected resources remain set 
to dial-in. If you want them to be dial-out, you will need to manually change the 
settings. See Changing Dial-In Settings for Individual Resources on page 23. 

Forcing MCU Usage  
The Force MCU usage is set automatically if you specify Bridged Audio Only. You 
may also want to use this setting if you want to require all endpoints to dial in to a 
single number and connect inside the same bridge. When this setting is not selected, 
the endpoints can connect directly to each other with either point-to-point 
configurations or using one endpoint’s built-in MP capability. 
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Setting the Video Mode for Multipoint Calls 
The Video Mode setting determines the initial screen layout on an endpoint’s monitor 
during a multipoint conference if it requires a stand-alone bridge.  

You can select Switching, so that the display changes each time the speaker 
changes, and everyone sees the current speaker. Or you can select the number of 
panels to be shown, so that you can see all of the meeting participants at once.  

If you select more windows than there are participants, the extra windows simply 
display with a background color. 

Note:  When selecting a video mode, it’s a good idea to consider the MCU resources that it 
will require. Normally, Switching mode consumes fewer MCU resources than 
Continuous Presence mode. The greater number of small video windows that are 
used, the more video resources required on the MCU. 

 

Using Auto-Start or Manual Start for a Conference 
When Auto-Start is selected in the Advanced Settings dialog box, the call will be 
dialed automatically at the start time of the videoconference, or a little before, based 
on any required start minutes. 

If you prefer to start conferences manually at the time of the conference, uncheck this 
setting. However, if you uncheck it, you must be sure to start it manually at the 
scheduled time. Otherwise, the conference will not launch. 

Setting the Default Connection Speed for a Call 
The speed set here will determine the speed at which the endpoints will communicate 
for both point-to-point and multipoint conferences. If a higher speed is selected than 
can be supported by an endpoint, the speed for that endpoint will be reduced, but it 
will remain at the default connection speed for the endpoints that can match it. If the 
calls are placed via a multipoint-capable codec, the behavior depends on the 
capabilities of that codec. 
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In the case of ISDN dialing, if the dial speed is higher than number of channels 
defined in the H320 service of the endpoint, you will receive a warning about 
exceeding ISDN resources. If that occurs, simply lower the dial speed to less than or 
equal to the ISDN capability of the endpoint 

Higher speed is important when you want high quality video in a meeting. Because 
higher speed uses more bandwidth, scheduling a meeting with higher speed may limit 
the number of conferences that can be reserved at one time. 

Using People + Content 
This setting controls the ability for one of the endpoints to send two types of data—
video and data—over the same bandwidth, so that both people and content can be 
displayed. The two video streams are handled differently by the receiving endpoint, 
and may be shown on separate screens, or through Video Switching mode. 

Note:  The MGC requires that conferences with People + Content use a Speed of at least 
192 K. If you set the Speed to 128, the conference will fail.  

Select the type of People + Content capability you want the conference to use. If you 
do not want to display both people and content in this conference, leave this setting 
as “None.”  

A conference can have only one People + Content setting. What you select here 
determines the setting to be used for all participants in the conference.  

Endpoints in the conference that don’t support the selected method will connect with 
either video (if they connect via IP) or audio only (if they connect via ISDN). 

The available settings include: 

 None 

 People+Content 

 People and Content VO  

 Visual Concert PC 

 Visual Concert FX 

 H320 Duo Video 

None 
Select “None” when dual-streams of data are not required. 

People + Content 
This Polycom proprietary technology works with most Polycom endpoints.  
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People and Content V0 
Polycom proprietary technology that works mainly with PictureTel endpoints. Select 
this option when working with older endpoints. 

Visual Concert PC 
PC-based software available with Polycom ViewStation MP/512/SP/323.  

Visual Concert FX 
Hardware solution available with Polycom ViewStation FX/EX and VS4000.  

H320 Duo Video 
Dual stream mode available with Tandberg endpoints in which one part of the 
conference is set as the videoconference and the other as the presentation 
conference. This selection supports both IP and ISDN. 

Using T.120 
Polycom ReadiManager LX100 allows you to define T.120 conferences, and to select 
the speed for the T.120 connection. Select “None” to disable the T.120 mode.  

T.120 is a standard that contains a series of protocols and specifications describing 
application sharing in multi-point data communication. The following options may be 
available, depending on the participant equipment and software: 

 Application sharing, allowing two or more conference participants to work on the 
same document/application even if only one participant has the application. In 
application sharing, one participant launches the application and it runs 
simultaneously on all the other computers. 

 File transfer to all conference participants.  
 Chat or "Whiteboard" in which participants communicate with each other via 

writing.  
In all of these modes, the participants can view and hear each other.  
From the T.120 drop-down box, select the speed for the T.120 connection. The 
higher rates (larger numbers) enable faster data transfer rates, but reduce the 
bandwidth available for the video portion of the call. In low bandwidth calls of 128 
kbps, use the smallest bandwidth numbers for the T.120 setting. Check with the IT 
department to determine the best combinations for your conferences. 

Notes:  Selecting this option uses T.120 resources on the bridge. It is best not to select it 
unless you are sure you want to use it. 
 
T.120 cannot be added to a conference that has already started. 
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Chair Control PIN 
You can enter a four-digit Chair Control PIN, to be used by the bridge during the 
conference.  

Note:  Be sure to make note of this PIN in your own records. You will need to communicate 
the PIN to the conference chair separately. It is not sent out in a conference email 

Updating Your Calendar with Scheduled 
Videoconferences 

Videoconference schedules are stored in the Polycom ReadiManager LX100 
database. When conferences are created in Outlook, they will be synchronized with 
the Polycom ReadiManager LX 100 database. If you schedule conferences from the 
Polycom ReadiManager LX100 web interface, you can synchronize your Microsoft 
Outlook Calendar to show videoconference.  

In addition, if you are a conference administrator and want to view all scheduled 
conferences in Microsoft Outlook, you can update your Microsoft Outlook Calendar to 
show them. 

Tip:  If you want to review all scheduled videoconferences, you may want to create a 
separate Video Calendar on which to display them, so that they do not clutter up 
your personal calendar of appointments. For details, see Setting up a 
Videoconferencing Calendar on page 42. 

To update your Outlook Calendar 

1. Go to your Calendar in Outlook.  

If you have more than one Calendar folder set up, select the one on which you 
want videoconferences to be shown. 

2. From the Video menu, choose Update Calendar. 

3. In the Calendar Date Range dialog box, select the starting and ending dates to 
indicate the date range of scheduled videoconferences you want to view on your 
calendar.  
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4. Select whether you want to see only conferences you scheduled, or all 
conferences (if you are a Conference Administrator), and then click OK. 

Scheduled videoconferences appear on your Outlook Calendar. 

To remove a videoconference from your Outlook Calendar  

 Right-click on the conference you want to remove and choose Delete. 

 

Managing Scheduled Conferences 
After a videoconference has been scheduled, you can make changes to it using the 
Manage Conference feature from the Video menu. When you choose it, the Manage 
Conferences window opens.  

 

Clicking the Globe loads the conferences into the window. The default filter for 
conferences is from seven days in the past to 30 days in the future. To see additional 
conferences, follow the steps described below, under Locating the Conference You 
Want to Manage. 
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Locating the Conference You Want to Manage  
Use the Filters tab to help identify the conference you want to work with. Filtering for 
scheduled conferences works very similarly to filtering resources when scheduling a 
conference. 

To locate the conference you want to manage   

1. From the Video menu, choose Manage Conference. 

2. Click the Filters tab so that you can narrow your search for a particular 
conference. 

3. Enter a date range, conference name, conference ID or reference number for the 
conference. The initial date range is from seven days prior to today, to 30 days 
after today. Expand the date range to see other conferences at the same time. 

 

4. Click the Conference List tab. Conferences that match your criteria are available 
in a hierarchy by date. 
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5. Expand the folders to find the conference with which you want to work. 

 

As the Legend indicates, the icons next to the conference give visual information 
as to when the conference is scheduled. 

Black: Conference was in the past. 
Green: Conference is currently active. 
Blue: Conference will occur in the future. 
Red: Conference failed to start. 
Yellow: Conference needs approval. (See Approving a Requested Conference 
on page 32.) 

6. Right-click on the conference and select the appropriate action from the menu. 

 For conferences that have already taken place, Close is the only available 
action. 

 For conferences in the future, Conference Details, Edit Conference, and 
Delete Conference are available.  

Approve Conference may also appear, if you are a Conference 
Administrator. 

 For active conferences, only Manage Conference is available. 



Managing Scheduled Conferences  

32  Polycom ReadiManager LX100 Scheduling in Outlook 

Approving a Requested Conference 
When users with the user profile “Request Only” schedule conferences, the 
conferences are reserved but will not launch. They must be approved by a 
Conference Administrator before they can occur. The Conference Administrator 
receives an email when a conference needs to be approved. 

To approve a requested conference 

1. Locate the conference that needs approval. (For details, see Locating the 
Conference You Want to Manage on page 30.) 

2. Right-click on the conference icon and choose Approve Conference. 

 An email is sent to the person who requested the conference. 

Deleting a Conference 
Conferences can be deleted from the Manage Conferences window. 

To delete a conference 

1. Locate the conference you want to delete. (For details, see Locating the 
Conference You Want to Manage on page 30.) 

2. In the Conference List tab of the Manage Conferences window, right-click on the 
conference you want to delete and choose Delete Conference. 

3. When asked to confirm, click Yes. 

If the conference was part of a series of repeated conferences, a message asks 
wheter you want to delete only this message, or the whole series.  

The conference is deleted. Email messages are sent to the facilitators for the 
resources involved. 
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Making Changes to a Future Conference 
All of the features available when you first schedule a conference can be used to 
make changes to a conference before it starts. 

Note:  If you make a change to a conference that was part of a series of repeated 
conferences, the change is made only to the selected conference, and not to the 
series. 

To make changes to a future conference 

1. Locate the conference you want to change. (For details, see Locating the 
Conference You Want to Managen page 30.) 

2. In the Conference List tab of the Manage Conferences window, right-click on the 
conference you want to change and choose Edit Conference. 

 

The Edit Conference window opens. This window is very similar to the 
Conference Resources tab you use to schedule a conference.  

3. Make desired changes to the resources, conference time, contact information, 
and guests. 

4. When finished making changes, click Update Conference. 

For details about working in this window, see the information presented earlier in 
the section Scheduling a Videoconference on page 4. 

Note: To NOT save the changes to the conference, click the close box in the upper corner 
of the window without clicking Create Conference.  
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Entering Additional Conference Details 
Sometimes conferences have additional details that need to be tracked. For example, 
when the request/approve conference feature is used, the administrator needs to be 
able to enter comments as to why a conference is approved or not. Or there may be 
special requirements related to setting up a conference. To accommodate this, details 
about the conference can be added after the conference is scheduled. 

To enter additional conference details 

1. Locate the conference for which you want to add details. (For details, see 
Locating the Conference You Want to Manage on page 30.) 

2. In the Conference List tab of the Manage Conferences window, right-click on the 
conference and choose Conference Details. 

The Conference Details dialog box appears. 

 

3. Enter the information you want to track for the conference and click OK. 

The Alias field can be used to assign a conference ID. 

The Setup field is for any comments about the conference. 
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Managing an Active Conference 
A conference that has started is considered an active conference. There are a 
number of adjustments you can make while a conference is active. You can: 

 Add and remove resources 

 Add a guest 

 Temporarily disconnect a resource 

 Reconnect a resource that was previously disconnected 

 Extend a conference 

 Restart a conference 

 End a conference 

To make changes to an active conference 

1. Locate the conference you want to change. (For details, see Locating the 
Conference You Want to Manage on page 30.) 

2. Select the conference, right click and choose Manage Conference.  

The Manage Conference and Resources window opens. 

 

You see the resources that are in the conference in the Selected Resources list.  

Note: Changes that effect resources and guests (adding, removing, disconnecting, 
and reconnecting) can only be made up until 5 minutes or less is left in the 
conference. After that you will only have the option of extending or ending the 
conference. 
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To add a resource   

 Select the resource and click Add. 

ReadiManager LX100 checks for the resources’ availability. If the resource is 
able to join the conference they are called and the resource is reserved for this 
conference time.  

To remove a resource  

1. Select the resource from the Selected Resources list and click Remove. 

2. When the confirmation message asks you to confirm that you want to remove the 
resource, click Yes.  

The resource is taken out of the conference and freed up for other possible 
conferences. 

To add a guest 
A guest can only be added if there is multipoint capability in either a video codec or 
MCU in the conference. If there is no multipoint capability in the conference, a guest 
cannot be added.  

1. Click the Guest button. 

2. In the Conference Guest dialog box, enter the name and number, choose the 
type of connection, and click OK. 

ReadiManager LX100 attempts to connect the guest to the conference. When the 
guest has been added, their name appears in the Selected Resources list. 

You can add multiple guests, but only one at a time.  

To disconnect a resource 

1. Select the resource you want to temporarily disconnect in the Selected 
Resources list. 

2. Click the Disconnect button.  

3. When the confirmation message asks you to confirm that you want to disconnect 
the resource, click Yes.  

Note: Disconnected resources are still associated with the conference and are not 
available for other conferences. The most common use of Disconnect is when 
you want to disconnect a resource for short time, but still want it to be available 
later in the conference. If you want to disconnect a resource and have no more 
need for it, use the Remove button instead. 

To re-connect a disconnected resource 

1. Select the resource you want to reconnect in the Selected Resources list.  

2. Click the Connect button.  
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To extend a conference 
This feature affects all the resources in your conference. If you indicate you want to 
extend the conference by 45 minutes, ReadiManager LX100 checks to see if all the 
resources are free for that time. (All resources must be available for the extended 
time. If one resource is not available then you can not extend the conference.) If you 
receive a message that the conference cannot be extended, try extending it for a 
shorter period of time 

1. Click the Extend Conference button. 

2. In the Extended Conference dialog box, select the number of minutes by which 
you want to extend the conference and click OK. 

 

To restart the conference 

1. Click the Restart Conference button. 

2. When the confirmation message asks you to confirm that you want to restart the 
conference, click Yes.  

This restarts your entire conference. All resources will be disconnected and then 
reconnected. 

To end a conference 
Use this feature to end a conference that did not go as long as scheduled. That way, 
resources used in the conference are freed up to be used for other conferences.  

1. Click the End Conference button. 

2. When the confirmation message asks you to confirm that you want to end the 
conference, click Yes.  
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Closing a Completed Conference 
Conferences that have already occurred can be closed. When you close a 
conference, you indicate whether it completed successfully or not, and can add 
comments about it. Reports can include comments; so entering comments gives you 
a way to track information about completed conferences.  

Closing conferences is optional. 

To close a completed conference 

1. Locate the conference you want to close. (For details, see Locating the 
Conference You Want to Manage on page 30.) 

2. In the Conference List tab of the Manage Conferences window, right-click on the 
conference you want to close and choose Close Conference. 

 

3. In the Close Conference dialog box, indicate whether the conference completed 
successfully, enter any comments, and click OK. 

The conference is removed from the Conference List. 
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Setting Up Microsoft Outlook for Use with Polycom 
Video Conferencing  

Polycom ReadiManager LX100 can be integrated right into Microsoft Outlook, so that 
you can schedule and manage conferences along with other meetings. 

Requirements 
You must be using Microsoft Outlook version 2000 SR-1 or later, or XP. If you have 
Outlook version 2000, you can download the Service Release (SR) from the Microsoft 
website.  

Installing the Polycom Video Conferencing Outlook Component 
The Polycom Video Conferencing component used with Microsoft Outlook is available 
from your Polycom ReadiManager LX100 application web page. 

To download the Polycom Video Conferencing Outlook component 

1. Log on to the Polycom ReadiManager LX100 application as you normally would 
through a web browser. 

2. From the menu bar, choose Support > Downloads. 

3. Click the link to the program pcsoutlook.exe. 

4. Save the program to your computer. 

To install the Polycom Video Conferencing Outlook component 

1. Make sure Microsoft Outlook is closed. 

2. Locate the file pcsoutlook.exe you just saved on your computer and double-click 
it to start the installation process.  

3. Follow the prompts on the screen from the install wizard to complete the 
installation. 
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You are asked for the information in the screenshots above and below so that 
Polycom ReadiManager LX100 can enter it into the appropriate location inside 
Outlook. Your Polycom ReadiManager LX100 Administrator may need to provide 
you with the applicable information.  

 

After installation is complete, start Microsoft Outlook; you will see a new menu, 
named Video in Outlook.  

The user settings you entered during installation now appear on the Logon 
Settings screen. If you want to review them, choose Logon settings from the 
Video menu.  
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Logging On from Microsoft Outlook 
You enter logon settings during installation which are saved in Outlook, so you do not 
normally need to log on to Polycom ReadiManager LX100.  

If your logon settings change at any time, you can reenter your logon information.  

Note:  If your network uses LDAP, you may need to log on to Polycom ReadiManager 
LX100 on the web before you can do so from Outlook. For assistance, contact your 
Polycom ReadiManager LX100 Administrator. 

To enter logon information 

1. Start Microsoft Outlook. 

2. From the Video menu, choose Logon Settings.  

The Logon Settings dialog box appears, displaying the login informaiton you 
entered during installation. 

 

3. To make changes to your logon information: 

 Use your Polycom ReadiManager LX100 user name and password in the 
User Name and Password fields. 

This is the same logon information you use to access the Polycom 
ReadiManager LX100 web application.  

The password is case-sensitive, but your user name is not. 

 The Server IP is the same as the one you use to access the Polycom 
ReadiManager LX100 web application. 

 For DSN, enter PCS.  

 The Port field is automatically completed. Leave the setting as it appears 
unless told to change it by your Polycom ReadiManager LX100 
Administrator.  

4. Click Save to save the changes. 

5. When message tells you that the changes have been saved, click Exit. 
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Setting up a Videoconferencing Calendar 
If desired, videoconferences can be displayed on a separate calendar. While for most 
users, adding videoconferences to your regular calendar is adequate, it can be useful 
for conference administrators who want to see all scheduled videoconferences to 
keep a separate calendar. That way videoconferences do not clutter the 
administrator’s personal calendar. 

Note: If you schedule videoconferences from a second Calendar, when you click the Send 
button to send conference invitations to participants, you will see a message from 
Microsoft Outlook that it will not be able to tally the responses for you. This is 
because responses to meeting requests can only be tallied on the main Outlook 
Calendar. 

To add videoconferencing to your standard calendar 

1. From the Folder window, right-click the Calendar and select Properties at the 
bottom. 

2. On the General tab, highlight the drop down box at “When posting to this folder, 
use:” and highlight “VideoMeeting”. 

 

To create a separate videoconferencing calendar 

1. Create a new Outlook Folder (from the File menu, choose New > Folder). 

2. In the Create New Folder dialog, change the selection in the Folder Contains field 
to Calendar Items. 

3. In the Name field, enter Video Calendar (or whatever name you want). 

 

4. Click OK. 

5. In the Outlook bar, right-click on the new Video Calendar icon and select 
Properties. 
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6. In the General Tab, in the field “When posting to this folder, use”, select Forms. 

 

7. In the Choose Form dialog box, select Personal Forms Library from the Look In 
field. 

 

8. Select VideoMeeting in the list and click Open.  

VideoMeeting now appears in the field “When posting to this folder use.” 

9. Click OK to close the Video Calendar Properties dialog box. 
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Uninstalling the Outlook Component of Polycom 
ReadiManager LX100  

Uninstalling the Outlook Plug-in from your computer requires two main steps: 

 Uninstalling Polycom ReadiManager LX100 Outlook client 

 Removing the VideoMeeting form 

To uninstall the Polycom ReadiManager LX100 Outlook client 

1. Open the Add or Remove Programs control panel 

2. Select and remove the Polycom Video Conferencing Outlook program. 

Note:  You can also uninstall the Polycom Video Conferencing Outlook client by running 
the install program, pcsoutlook.exe. 

To remove the VideoMeeting form 
Leaving the VideoMeeting form on your system should not cause any problems, 
however if you want to remove it, you can do so. 

1. In Microsoft Outlook, right-click on the Calendar icon and choose Properties. 

2. Click the Forms tab. 

3. Select the VideoMeeting form and click Manage.  

4. In the Forms Manager dialog box, select the VideoMeeting form on the right and 
click Delete. 

5. When prompted to confirm the deletion, click Yes. 

Checking the Version of the Polycom Polycom Video 
Conferencing Client Application  

If you encounter difficulties scheduling videoconferences through Outlook, you may 
need to check the version number of the Polycom Video Conferencing Client 
Application (the VideoMeeting form). 

To check the version of the VideoMeeting form 

1. Right-click on the Calendar icon and choose Properties. 

2. Click the Forms tab. 

3. Select the VideoMeeting form and click Manage. 

The version number appears in the lower part of the Forms Manager dialog box. 

If you do not see the form, contact your Polycom ReadiManager LX100 
Administrator for assistance. 
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Trouble Shooting 
If a run-time error occurs while using features from Polycom ReadiManager LX100, 
you must exit and restart Outlook. Upon restarting, you may receive the following 
error: 

Outlook experienced a serious error the last time the add-in ‘pcsoutlook’ was 
opened. Would you like to disable this add in? To reactivate the add-in, click 
About Microsoft Office Outlook on the Help menu, and then click Disabled Items. 

Polycom ReadiManager LX100 can only be used when the add-in is enabled. If you 
disable ‘pcsoutlook’ in response to this message, you will need to re-enable it as 
described in the message before you can schedule additional conferences. 
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